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FileNet Document Publisher Introduction
Introduction

With FileNet Document Publisher Station, you can create a range of web pages, 
from the simple to the sophisticated. In these seven lessons, you will begin by 
producing simple web pages. Specifically, you will

Lesson 1 — Open, translate, and view a sample publication

Lesson 2 — Create a new publication

Lesson 3 — Learn about templates and global settings

Lesson 4 — Learn about elements, styles, and patterns

Lesson 5 — Apply formatting

Lesson 6 — Create a table of contents (TOC) for a publication

Lesson 7 — Add navigation buttons

Each lesson introduces you to important features of Document Publisher Station. 
Once you have acquired the skills needed to create simple web pages, you can 
continue with the Tutorial for an in-depth look at what Document Publisher Station 
can do. 

About concepts and terms
As you work through these lessons, you will encounter concepts and terms that are 
either specific to Document Publisher Station or are used in Document Publisher 
Station in a special way. It is important that you understand them. If, during a 
lesson, you find yourself unsure about a particular concept or term, you might want 
to revisit the Getting Started manual, in particular, the section Key Terms at the end 
of the Chapter 2, “How Document Publisher Station Works.” In addition, a complete 
glossary of terms is available online (choose Glossary from the Help menu).

If the interface becomes confusing to you at any time, you may want to review 
Chapter 1, “Introducing FileNet Document Publisher,” as well as later chapters in 
Getting Started that discuss other features of Document Publisher Station in detail. 

Command options
In Document Publisher Station there is often more than one way to choose a 
command. Most commands are available from both the menu bar and the standard 
toolbar, and in some instances there are additional options. For example, to open 
an existing publication, you could do any of the following:

Startup Screen — Select Open an existing publication and click OK.

Toolbar — Click Open .

File menu — Choose Open.

Keyboard shortcuts — Crtl+O or Alt, F, O.

In these lessons, we will use just one way (mostly clicking buttons on the toolbar). If 
you are more comfortable with an alternative method, feel free to use that, instead.
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FileNet Document Publisher Introduction
About styles and patterns
Document Publisher Station works best when your source documents contain either 
named styled content or manually formatted content. A named style is where you 
create a style by defining a set of formatting characteristics and giving those 
characteristics a specific style name. (You can then apply the style at any time by 
selecting one or more paragraphs in the document and selecting the style name 
from a list of styles.) Manually formatted content is where you select text and 
change its look, or attributes, by applying the different characteristics (font size, 
bold, italic, etc.) individually. 

In Document Publisher Station, a source document is either styled or manually 
formatted (we sometimes refer to the latter as “unstyled”). We refer to named 
styles simply as styles. When a manually formatted document is brought into 
Document Publisher Station, patterns are created by Document Publisher Station to 
identify the distinct, manually formatted content. Document Publisher Station works 
best where styles or patterns are consistently applied to a source document. Since a 
manually formatted source document is often more difficult to format than one with 
styles, you will be working with a patterned or “unstyled” document in this series of 
lessons.

Note: Document Publisher Station also has the ability to apply “ranks” to source 
documents. This can be especially useful when you have a number of documents 
where the hierarchy of their content is clearly delineated within each document but 
is not consistent between those documents.

For example, one source document may contain the named styles Title, Heading 1, 
Heading 2, and Body Text, whereas another may have the same hierarchy imposed 
by manual formatting. (That is, the content of the second document is completely in 
the Normal style, with the title formatted with the same characteristics as the Title 
style in the first document, and so on.)

Document Publisher Station can analyze such disparity in formatting and create 
ranks that will allow you to apply consistent formatting across all documents. This is 
explained in the Tutorial (available from the Help menu and also the Startup 
Screen).
6
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LESSON 1

A sample publication

In this lesson, you will learn how to

Open an existing publication

Translate the source document contained in that publication

View the web page produced as a result

Beginning in Lesson 2, you will learn how to create the web page you will view at 
the end of this lesson. 

Key concepts
When you start a project in Document Publisher Station, you begin by working in 
the root publication, which contains one or more source documents, any optional 
reference pages you choose to build, and the templates you use to format the 
source documents and reference pages. The root publication can contain other 
publications, which become subpublications of the root publication and, together 
with the root publication, form a publication hierarchy. You will learn about creating 
a publication hierarchy in the Tutorial. In these lessons, you will work with a simple 
publication.

When translated, the publication becomes a web publication, consisting of one or 
more web pages for each source document and any reference pages you create. 
Each publication has its own project file, which is used to save important details. 

When Document Publisher Station translates a source document, it takes the 
content of the document, reformats it per your instructions in the template, and 
produces an HTML file, which it places in a designated output directory. (The source 
document remains unchanged.) That file is the web page you view in your web 
browser. Reference pages are different. They are built by Document Publisher 
Station during translation and derive their content from the source documents. 

Exercise
If the Startup Screen is open in the main window of Document Publisher Station (see 
Figure 1-1), note that your options include the ability to open an existing 
publication or to specify the last publication you used. Click Cancel to close the 
screen.
7
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Figure 1-1  The Startup Screen, which opens in the main window each time you start Document 
Publisher Station. If you click Don’t Show This Screen Again, you can open the Startup Screen at any 
time from the Help menu.

Before we begin, take a quick look at the main window. In the Publication Hierarchy 
pane you will see “<Unnamed>,” and just above the Contents pane you will see 
“Contents of: <Unnamed>”. These two places are where the name of your 
publication always appears. On the title bar you will see “Unsaved – Document 
Publisher Station.” This is where the name of the project file always appears.

Let us open an existing publication, which we do by opening its project file.

To open an existing publication

 1.  Click Open  on the toolbar.

 2.  If the Select a Repository dialog box opens, click Don’t show this dialog box 
again, accept the default File System, and click OK.

 3.  In the Open dialog box, locate the Samples folder in the FileNet Document 
Publisher directory. (If you accepted the default directory during installation, 
the path is C:\Program Files\FileNet Document Publisher\Samples\en.) 

 4.  Select Lessons.tcp from the file list and click Open. Document Publisher 
Station opens the project file Lessons.tcp.

Note how the main window has changed (see Figure 1-2). The name of the project 
file appears in the title bar. The name of the publication, which also happens to be 
Lessons (but does not have to be), appears in the Publication Hierarchy pane and 
also above the Contents pane. In the Contents pane are details about the 
publication. In Document Publisher Station, a publication can contain many 
documents. Our sample is a simple publication that contains just one source 
document and one reference page. Each has its own template. (You will learn more 
about templates later.)

By the way, if you want to see the full path and file name for the source document, 
place the mouse on the divider that separates the Source and Template columns. 
When the cursor changes from an arrow to a cross, move the divider to the right. 
You can adjust the width of the other columns in the same way. You can also 
8



FileNet Document Publisher A sample publication
improve your view of the Contents pane by dragging the large toolbar and 
repositioning it on the desktop or by hiding it altogether (by choosing Large Toolbar 
from the Toolbars submenu of the View menu).

You now want to turn the source document into a web page.

To translate the publication 

 1.  Click Translate  on the toolbar. The Update Versions dialog box opens.

The toolbar button is for an incremental translation, which will suffice in most 
instances. (It is the same as a full translation the first time you translate any 
project.) To ensure a full translation for a project that has previously been 
translated, use the Translate All command on the Run menu.

 2.  In the Update Versions dialog box, accept the default and check Don’t show 
this dialog box again.

This dialog box is relevant only when your project contains Directory Items (see 
the Tutorial, Lesson 15, for more information).

Once you translate the source document, you can open your web browser to view 
the web page you created.

To view the web page

 1.  In the Contents pane, select the source document.

 2.  Click View  on the standard toolbar.

Figure 1-2  The Document Publisher Station main window, showing publication details. If you click 
below the list of publications in the Contents pane, you will deselect any output page that is already 
selected. If you then click View, your web publication will open at the first output page in the list of 
files—in this case, the TOC.

Your web browser displays the web page you just created. At the top of the web 
page click the TOC button to jump to the Table of Contents (see Figure 1-3). This is 
the web page that Document Publisher Station created from the Table of Contents 
reference page shown in the Contents pane. 
9
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Figure 1-3  The table of contents for the Lessons publication. The two-part title is composed of the 
publication name and the default document title for the TOC.

Navigation buttons like this TOC button are common in web publications and are 
easy to add in Document Publisher Station. In the TOC page, you can see a title and 
some blue hot spot text. The title, “Lessons Table of Contents,” has two 
components: “Lessons” is taken from the publication name, and “Table of Contents” 
is the default title that Document Publisher Station assigns to every TOC. You will 
learn more about titles in the Tutorial. The blue hot spot text comes from headings 
in the source document. Click one of these headings—say, “Source Documents”—
and you will return to the web page for the source document itself. 

Summary
You have just opened a project file, translated the source document for the 
publication, and viewed the resulting web page in your web browser. You also 
viewed a simple table of contents that was created automatically by Document 
Publisher Station, using content derived from the source document. This is a simple 
publication, which you will now create from scratch on your own in the following 
lessons. 

Once you learn how to set up a publication, you will discover that updating your 
web page can be as easy as

Revising your source document in its native format

Opening your project file

Translating and viewing the publication

In the next lesson, you will learn just that, as you create a new publication and 
select source documents for translation. 
10
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LESSON 2

Creating a new publication

In this lesson, you will learn how to start a new project and create your own web 
pages. Specifically, you will

Start a new project

Name the project file 

Add a source document to the root publication

Create a new template

Translate and view the publication

Key concepts
When you add a source document to a publication, you associate a template with 
that document. If it is a styled document, Document Publisher Station can import 
the styles from the document. If it is a manually formatted document, Document 
Publisher Station can identify patterns in the document and import these, instead. 
(Document Publisher Station can also apply “ranks” to source documents; this is 
discussed in the Tutorial.) Document Publisher Station associates each style or 
pattern with an element, which it generates automatically, and places the elements 
in the template. You can associate only one template per document, but you can 
associate the same template with many different documents.

You use the elements to format the content of your source document and to 
determine the look of the web page you create. The formatting instructions are 
saved in the template, which, in turn, is saved in the project file.

Exercise
To start a new publication

 1.  Click New  on the toolbar. If you did not close Document Publisher Station 
after Lesson 1, Document Publisher Station will prompt you to save the project 
file Lesson.tcp. Click Yes. 

The Publication Properties dialog box now opens. Here, you can name the 
publication and specify directories for output files. The default output directory 
shown will depend on which version of Windows you are running (see the 
Introduction to the Tutorial for more information). But you can place the files in 
any drive or directory, local or network. And you can use different directories 
for output pages and graphics.

 2.  Type MyLesson in the Publication Name text box and also in the Publication 
Title text box. Typically, you will want to use the same name for both the 
publication name and title, but you do not have to. (You will learn about titles 
in the Tutorial.)
11
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Change the output directories for pages and graphics if you want to use a 
location other than the default directories shown.

 3.  Click OK.

You have named your new publication. The new name appears in the Publication 
Hierarchy pane and just above the Contents pane. But the title bar still reads 
“Unsaved.” That is because Document Publisher Station lets you name a publication 
and its project file differently, and you have not yet named the project file.

To name the project file

 1.  Click Save  on the toolbar.

 2.  The Save As dialog box opens, with the default project file name MyLesson.tcp 
(based on the publication name) highlighted in the File Name text box. Type 
MyProjectFile and then locate and open the Samples folder in the FileNet 
Document Publisher directory (where Lessons.tcp is). You do not have to give a 
project file the .tcp extension. Document Publisher Station will do this for you.

 3.  Click Save. Document Publisher Station has saved the new project file, with the 
.tcp extension. The name of the project file appears in the title bar.

The next step is to tell Document Publisher Station which source document you 
want to turn into a web page. 

To select a source document 

 1.  Click Add Document  on the toolbar. 

 2.  The Add Document dialog box opens. In this dialog box you select the 
document you want to add to your publication. Browse to the ..\FileNet 
Document Publisher\Samples\en subdirectory and open the Formatted folder 
(see Figure 2-1).

 3.  Select Source Documents.doc and click Open. The Add Document dialog box 
closes. You may then see several progress dialog boxes appear briefly 
onscreen as Document Publisher Station loads the browser controls to prepare 
the Preview window for the Choose Template dialog box, which then opens.

Figure 2-1  The Add Document dialog box, where you select documents for translation. 

When the Choose Templates dialog first opens, it displays a default translation of 
the source document in the Preview window (see Figure 2-2). This is done using the 
Academy template, the first template in the Templates list. You can select any other 
12
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template from the Templates list to associate with the source document, or create a 
new template. 

Figure 2-2  The Choose Template dialog box, showing the Academy template associated with the 
source document. The Preview window automatically displays a temporary translation of the source 
document when the Auto check box under Preview Updates is selected.

To see how template settings can affect the look of a source document when the 
document is translated, select another template from the list, for example, 
Administration. As soon as you do so, Document Publisher Station retranslates the 
source document, this time applying the settings from the Administration template. 
You can see the results in the Preview window. Document Publisher Station did this 
automatically because the Auto check box under Preview Updates is selected by 
default. You can clear this check box, if you prefer, and use the Update Now button 
to selectively update the template settings in the Preview window.

Note: What you see in the Preview window in the Choose Template dialog box (and 
also in the Edit Template dialog box) are temporary translations done solely for 
preview purposes. These are placed in temporary files and are not available for 
viewing in your web browser. In other words, having used this Preview window to 
help you edit templates and create web pages to your liking, you must still return to 
the main window to translate the source documents and create output pages for 
viewing in your web browser.

In this lesson you are going to create a new template for your document. When you 
work with a document that has been manually formatted, it is sometimes best to 
start with a new template, since the settings in the templates available in the 
Templates list may not exactly fit your needs.
13
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To create a new template

 1.  In the Choose Template dialog box, click the New button above the list of 
templates to open the New Template dialog box.

 2.  Type MyTemplate in the text box, and make sure that Body is selected under 
Template Type. Do not base the new template on another template. Just click 
OK. 

In the Choose Template dialog box you will now see MyTemplate already 
selected in the Templates list and therefore associated with the source 
document. That is why a rather plain web page now displays in the Preview 
window. 

 3.  Under Import Styles or Patterns, at the top of the Choose Template dialog box, 
select Patterns.

If you had accepted the default None, Document Publisher Station would have 
imported neither styles nor patterns from the source document. Moreover, it 
would not have created ranks, either (ranks are an alternative to styles and 
patterns), because you are creating a new template, not using an existing 
template in the Choose Template dialog box. This is explained in the Tutorial. 
For now, note that we have instructed Document Publisher Station to import 
patterns from our manually formatted source document.

 4.  Click OK.

The Progress dialog box appears briefly as Document Publisher Station imports 
patterns from the source document. Document Publisher Station creates an 
element for each pattern and places the elements in the new template, 
MyTemplate. (You will learn more about elements later.) The Choose Templates 
dialog box closes and you return to the main window, where the source 
document is now listed in the Contents pane, with the name of the new 
template MyTemplate in the Template column.

You have now done the minimum necessary to create a web page: created a 
publication containing a single source document and associated a template 
with that document. The next step is to translate your publication. But first you 
should save your project file. 

4 Click Save  on the toolbar.

You are now ready to translate the publication as you did in the last lesson.

To translate and view the publication

 1.  Click Translate  to translate the source document. 

 2.  In the Contents pane, click View  on the large toolbar. 
(If Internet Explorer is your default browser, the IE icon will display on the large 
toolbar, instead.)

Take a look at the web page you have just created (see Figure 2-3). It is the same 
one you previewed in the Choose Templates dialog box, and much simpler than the 
one you viewed in Lesson 1.
14
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Figure 2-3  Your first web page, as it appears in the web browser, with no special formatting. 

Summary
The web page you just created is quite simple. It lacks navigation buttons, 
separators that could help structure the content, icons that might be used for 
special effects, and even a background color or graphic. But in creating it, you 
completed the steps necessary to create any web page in Document Publisher 
Station: started a new project, named the project file, added a source document to 
the root publication, created a new template, and translated and viewed the 
resulting web page in your web browser.

As you continue through these lessons, you will learn how to create web pages like 
the one in Lesson 1. Keep your web browser open if you plan to start Lesson 3 right 
away. Otherwise, save the project file before you leave Document Publisher Station. 
You will need it for the next lesson.

Tip

You do not have to use the Add Document dialog box to add source documents to a 
publication. You can drag files from the folder hierarchy in Windows Explorer and 
simply drop them into the Contents pane in Document Publisher Station (the 
Choose Template dialog box will open each time).
15
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LESSON 3

Templates and global settings

In this lesson, you will learn how to

Select a graphics Set from the Gallery

Insert copyright information and an email address

These two seemingly unrelated tasks have something in common: they are both 
global settings. As you edit a template to turn a source document into a web page, 
you typically edit the individual elements in the template. But some instructions are 
set for the template as a whole, rather than for individual elements. 

Key concepts
Most of the options that affect your web page globally are to be found on the 
Globals property sheet. One of the most important is the opportunity to pick a 
graphics style to use for the background, navigation buttons, separators, and other 
visual elements you use to design web pages. 

Document Publisher Station comes with a large number of graphics, most of them 
arranged in matching Sets that can be picked from the Gallery. You can begin to 
appreciate these by entering the Choose Template dialog box for a selected 
template and switching between templates. Except for Blank, each template in 
Document Publisher Station has a graphics Set associated with it. So by doing this, 
you will be able to view a selection of the graphics available in Document Publisher 
Station. 

Since graphics are used in many different ways in Document Publisher Station, you 
can open the Gallery from three of the property sheets: Formatting, Navigation, 
and Globals. In Globals you can not only pick a Set, but also make it the default 
Set to be used automatically throughout your publication for the selected template. 
As a result, you do not have to search for a particular graphic each time to ensure a 
consistent look for your web publication.

Graphics Sets are therefore associated with specific templates in your web 
publication. Likewise, adding a copyright line to your web page and including an 
email address are template-based settings.

Exercise
 1.  Open MyProjectFile.tcp, the project file you created in the last lesson.

Remember: the project files used in your most recent sessions in Document 
Publisher Station are listed at the bottom of the File menu.

 2.  In the Contents pane, select Source Documents.doc.

 3.  Click Edit Template  on the large toolbar to open that dialog box (see 
Figure 3-1).
16
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The four editing commands down the right side of this dialog box are the same 
ones found in the Template menu and on the Template toolbar. We could have 
opened Globals directly from the menu or toolbar. The advantage of working 
in this dialog box is that you can move easily between the editing options 
offered by all four commands. 

Figure 3-1  The Edit Template dialog box. If the template is associated with more than one source 
document, you can click Change Preview to select one of the other source documents to view, instead.

Another advantage of the Edit Template dialog box is that the Preview window lets 
you see the changes to your template as you make them. (As you entered the dialog 
box, you may have noted that Document Publisher Station displayed several 
progress dialog boxes as it loaded the browser controls for the preview and created 
a temporary translation file in order to display your source document as a web page 
in this window.) Moreover, editing is simplified because as you pass your cursor 
over the Preview window, tooltips identify the names of the elements associated 
with the content of your source document. Try this now.

To select a graphics set

 1.  Click Globals  to open that property sheet.

 2.  Click Set to open that tab dialog. (You may have to click one of the arrow 
buttons at the upper right of Globals to display the Set tab.) Then click 
Gallery.
17
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Figure 3-2  The Gallery, opened from the Set tab dialog in Globals. When you open the Gallery from 
this tab dialog, you are automatically in the Sets mode. (The Groups mode is available only when you 
enter the Gallery from Formatting or Navigation.)

 3.  From the list of Sets, select several, in turn. Note how distinctive the designs 
are. The buttons you see are for navigation (which we address in Lesson 7). 
Each Set also includes a separator, bullet, and background effect.

 4.  Select Maroon Sand. 

 5.  Click the Make Default button to make this Set the default (its name is now 
bolded).

 6.  Click OK to return to the Set tab dialog.

 7.  Click Apply Set Selection, and click Yes when asked whether you want to 
apply the new default Set.

You have now picked a graphics Set and applied it to your template to replace any 
other Set you might have been using already. You have also simplified your choice of 
graphics throughout Document Publisher Station, because graphics from the default 
Maroon Sand Set will now be applied automatically whenever you select a 
navigation button, or any graphic, that is available from the Set.
18



FileNet Document Publisher Templates and global settings
Figure 3-3  The Globals property sheet with the Set tab dialog open. You can use the two arrow 
buttons at the upper right to scroll through all the tabs available.

In fact, the background graphic of this Set will be used automatically in your 
template. You can confirm this by switching to the Colors tab dialog (click one of the 
arrows to the upper right of Globals, if necessary, to display the Colors tab). Under 
Background Colors, Use a background graphic is already checked and the path 
and name of the graphic displays in the File Name text box. In addition, the 
background graphic can be viewed in the Sample box.

Because you chose Maroon Sand as the default graphics Set, Document Publisher 
Station automatically picks the background graphic from this Set. All web pages 
created with this template will have this background graphic. Document Publisher 
Station will do this for most graphic elements within the Set. Later, you will turn on 
the navigation buttons. 

Let us turn to the second global task. 

To insert copyright information and an email address

 1.  Click Address to open that tab dialog.

 2.  Under Address Lines, type Copyright 2005 in line 1.

 3.  Under Email Lines, make sure that Include Email Address is checked. In the 
Email Prompt text box type Email Comments, and in the Email Address text 
box type Youremail@youraddress.extension.

You have now added a copyright line and an email address to the web page.

 4.  Click OK to return to the Edit Template dialog box.

Since Auto, under Preview Updates, is the default setting, the Preview window 
immediately updates your source document. Note the new background, taken from 
the Maroon Sand graphics Set. Scroll to the bottom of the page and you’ll see the 
two lines you added. “Email Comments” is in blue hot spot text.
19
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Figure 3-4  The Address tab dialog in Globals. You do not have to enter an actual address in the 
address lines. In fact, you can enter any information you want. 

Though it is not evident, you can format the copyright line because a global element 
is assigned to Address information by default. We explain this element in the next 
lesson.

 1.  Click OK to return to the main window. 

You have saved all your changes to the template. 

 2.  Choose Save from the File menu or click Save  on the toolbar.

You have now saved the template, and these changes, to the project file.

Summary
You have just had a brief introduction to global settings available in Document 
Publisher Station. The judicious use of graphics can transform an ordinary web 
publication into one that is stylish and professional looking. With its 28 pre-
designed graphics Sets, each with its own distinctive look, Document Publisher 
Station lets you create professional-looking web pages with minimal effort. Global 
settings can be important, too, and Document Publisher Station offers many global 
options in the Globals property sheet.

Tip

Moving between the four property sheets from the Edit Template dialog box, as 
opposed to the Template toolbar on the main screen, can be especially helpful when 
you are doing a great deal of formatting on a new publication and want to quickly 
check the effect of your changes. Remember to pass your cursor slowly over the 
Preview window to display tooltips that will identify the elements you want to edit.
20



FileNet Document Publisher Elements, styles, and patterns
LESSON 4

Elements, styles, and patterns

In this lesson, you will learn how to

Check the patterns that Document Publisher Station identifies in a manually 
formatted source document and create a new pattern for specific content

Add a new element

Key concepts
When you add a source document to a publication, you have the option in the 
Choose Templates dialog box of accepting the default None, under Import Styles or 
Patterns, or choosing Styles or Patterns, instead. If you choose Styles, Document 
Publisher Station automatically looks for styles in the document. (By “style” we 
mean a set of formatting characteristics that are saved and given a name so that 
they can be applied to any paragraph in a source document.) If you choose 
Patterns, Document Publisher Station tries to identify patterns in the way that 
formatting characteristics have been applied manually to the content. (By “pattern,” 
we mean a set of font attributes that suggest the hierarchy of content in a source 
document. See “Key terms” in Chapter 2 of the Getting Started manual for more 
details.)

How successful Document Publisher Station is in recognizing patterns in a document 
is a function of how distinct the patterns are. That is why it is always best when 
Document Publisher Station imports patterns from a manually formatted document 
to check the patterns before you start editing the template. Often, you may find 
that you have to create a new pattern (and element) to handle a specific portion of 
the content.

When Document Publisher Station identifies patterns in a source document, first, it 
names them Pattern1, Pattern2, Pattern3, etc., in the order in which they appear in 
the document. Second, it determines the top three heading levels and assigns the 
elements Title, Heading 1, and Heading 2 to these patterns. Third, it assigns Default 
Paragraph, a special element, to all other patterns. Finally, it assigns an HTML tag 
to each element.

Note: When importing patterns, Document Publisher Station applies the Title 
element only if the highest-level pattern appears only once in the document (it does 
not matter where). Otherwise, the elements used would be Heading 1, Heading 2, 
and Default Paragraph.

The element name becomes a marker, or handle, for all content associated with the 
corresponding pattern in the source document. Document Publisher Station stores 
this information in a template, which is saved as part of the project file. When you 
import a document with styles, the process is similar, except that Document 
Publisher Station generates a element for each style. 

Note: With the default None selected in the Choose Template dialog box, 
Document Publisher Station applies a default set of “ranks” to content instead of 
importing styles or patterns. See Tips at the end of this lesson. 
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Exercise
The changes you will make to the template in this lesson are all done in the Element 
Setup property sheet. First, select Source Documents.doc in the Contents pane. 
Note that the Template commands are now active.

To open the Element Setup property sheet, click Element Setup  on the 
toolbar.

The Element Setup property sheet opens with the Elements tab dialog in front (see 
Figure 4-1). Opposite each element, in the In Body and In Page TOC columns, is a 
green check mark or red cross to denote whether the content associated with that 
element has been assigned to the body page and/or the page TOC. (You will learn 
about Split and Promote As in the Tutorial.)

Figure 4-1  The Element Setup property sheet, showing default settings for elements.

Since your source document has been manually formatted, the first step is to check 
the patterns that Document Publisher Station identified in the document and 
imported. The list of elements in the Elements tab dialog lists more elements than 
were imported from the source document. Two Default elements are assigned by 
Document Publisher Station to every template. In addition, three “system” elements 
are also included in every template. We can ignore these for the moment.

To check the patterns that Document Publisher Station identified

 1.  Click Patterns to open that tab dialog.

Here, you will see that Document Publisher Station has assigned four elements to 
the four patterns it identified in the source document (see Figure 4-2). The patterns 
are listed in their order of importance (headings first). Thus, while Heading 1 is 
listed second in the Element column, its name, Pattern3 (in the Pattern column), 
tells us that it was actually the third pattern that Document Publisher Station 
identified in the source document.

Click each pattern, in turn, and note how the information at the bottom of the tab 
dialog changes. The Pattern Details box lists the formatting characteristics for each 
pattern, while the Sample box to the left displays sample text. 
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Figure 4-2  The Patterns tab dialog in Element Setup. Patterns are listed in their order of importance 
in the document hierarchy (the element column), but are named in the order in which they appear in the 
document (the Pattern column). 

Document Publisher Station has identified three headings in the source document: 
Title, Heading 1, and Heading 2. It has assigned the element Default Paragraph to 
the remaining body text in the document. However, a closer look at Heading 2 
(select the heading and check the Pattern Details box) reveals that the text for this 
portion of the source document is 11 point italic. Moreover, as you may recall from 
viewing the document in the Preview window in Edit Template, this is not really a 
heading at all. Rather, it is an introductory paragraph of text immediately following 
the title.

This is an example of the sort of thing you need to review in Element Setup when 
you first import patterns from a source document. Ideally, you should assign a 
different element to Pattern2, one that better describes its content and will make 
more sense when you start editing the template. To do this, you must first create a 
new element for the introductory text. 

To add a new element

 1.  Click Elements to open that tab dialog.

 2.  Click New to open the New Element dialog box.

 3.  In the Name text box, type Introtext, and click OK.

In the Elements tab dialog, the new element Introtext now appears in the lower 
part of the Element list. It is grayed out to denote that it isn’t currently 
assigned to any pattern.

 4.  Click Patterns to open that tab dialog, select Pattern2, and click 
Association.

The Change Pattern Associations dialog box opens with a list of all the 
elements available in the template.

 5.  From the drop-down list of elements, select Introtext, and then click OK.
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In the Patterns tab dialog, Introtext appears opposite Pattern2. You have 
successfully reassociated the introductory text with the new element.

 6.  Click the Elements tab. Introtext is now listed in the top portion of the 
Elements list because it’s now an active element. At the same time, Heading 2 
is now grayed out, in the lower part of the list, because it is no longer assigned 
to a pattern.

 7.  Click OK to leave Element Setup and save your changes to the template.

 8.  In the main window, choose Save  from the File menu to save the 
template to the project file.

Summary
In this lesson you had an introduction to the Element Setup property sheet. It is 
always wise, when setting up a new publication, to spend a little time here to be 
sure that the styles or patterns you have imported are set up the way you want 
them to be.

The list of elements contains three we have not discussed: Address (System), Email 
(System), and Title (System). These are global elements, assigned specific purposes 
in Document Publisher Station. 

In Lesson 3 you created a copyright line (in the Address tab dialog of Globals), 
which appears in the web page in the default font style (Times Roman, italic). If you 
like, you could select the Address (System) element in Formatting to format this 
address line. However, since the <ADDRESS> tag is assigned to this element by 
default, any content associated with this element will always appear in italic, 
because that is how browsers interpret this tag. You could, instead, associate the 
<P> tag with this element to give you total freedom in formatting the content. 

The text “Email Comments” that you also added to your web page can be formatted 
by selecting the special element Email (System). You will learn about Title (System) 
in Lesson 6. (It is also discussed in Lesson 8 of the Tutorial.)

Tips

To import styles or patterns from a source document, you must formally select 
Styles or Patterns in the Choose Template dialog box. With the default setting 
of None, Document Publisher Station uses a default set of ranks to handle 
content hierarchy (see below).

Typically, you will want to select Styles when all your source documents are 
styled. Likewise, Patterns is the best choice if all your source documents are 
manually formatted. If you have a mixture of source documents that are 
inconsistently styled (some with named styles, some manually formatted), the 
default setting of None is your best choice.

With None, Document Publisher Station imports neither styles nor patterns. 
Rather, it uses a default set of ranks—Lowest 1, Title, Lowest 2, and Heading 
1—to help ensure that all top-level content in your source documents is styled 
in a consistent manner. You can supplement the default set of ranks with new 
ranks or patterns to help format unique portions of content.

Generally, you should use paragraph patterns only if all your source documents 
are manually formatted, or where you can be sure of successfully identifying 
special content (for example, a bulleted or numbered list). Character patterns 
are always useful; indeed, three character patterns are included in every 
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general-purpose template that ships with Document Publisher Station: HTTP, 
Weblink, and Email. (You have not seen these in Element Setup thus far 
because the template you created was not based on any of these general-
purpose templates. See Appendix B, “Templates and Graphics Sets,” of the 
Getting Started manual for more information.) 

Whatever setting you choose in the Choose Template dialog box will prevail 
across all projects until you change it again.

If you select None in the Choose Template dialog box when you add a 
document to a publication and you later decide to import either styles or 
patterns from that document, the solution is simple: right-click the document in 
the Contents pane in the main window and choose Import and then Styles or 
Patterns from the popup menu.
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LESSON 5

An introduction to formatting

In this lesson, you will learn how to

Change font size, color, and alignment

Add a separator

Change character settings

Key concepts
Once you have completed project setup and checked the assignment of elements in 
Element Setup, the next step is to decide how you want your web page to look. 
You do this in the Formatting property sheet, setting instructions for each element, 
in turn. When the settings are saved to the template, they apply to every source 
document associated with the template. 

Once you start creating your own web publications, you will find that most of your 
time is spent in Formatting. The wide selection of formatting options available 
include those that help structure your web pages, as well as others that add color 
and graphics to dramatically change the look of those pages. 

Exercise
 1.  Open MyProjectFile.tcp.

 2.  In the Contents pane, select Source Documents.doc.

Note: You actually select the whole line—the output page (.htm file), the 
source document, and the template. If you were to translate the source 
document and click View, your browser would recognize and open the output 
page. If you were to right-click, Document Publisher Station would recognize 
the source document and open a popup menu from which you could choose, 
for example, the Document Properties dialog box. Finally, if you click one of the 
template options (as you are about to do), Document Publisher Station will 
recognize the template file. 

 3.  Click Edit Template  on the large toolbar, and then click Formatting to 
open that property sheet (see Figure 5-1).

On the left is the Elements list, which shows the list of elements for the template 
selected. This is the same list you saw in the Element Setup property sheet. It is 
available in Formatting from all tab dialogs. You open the tab dialogs by clicking 
the tabs across the top of the property sheet (if necessary, click the arrow buttons 
at the upper right of the property sheet to display additional tabs). Each tab dialog 
offers a series of formatting options. The Character tab dialog, which is used to 
format text, is open by default.
26



FileNet Document Publisher An introduction to formatting
Figure 5-1  The Formatting property sheet. Click the arrow buttons at the upper right to display 
additional tabs.

Let us begin by formatting Title, the element associated with the first-level heading 
in the source document. To signify the title’s importance, we will apply a dark color, 
increase the font size and weight, and change the element’s alignment. All these will 
help to set off the title from the rest of the content. You will reinforce the title’s 
importance further by adding a separator.

To change color, font size, weight, and alignment

 1.  Select Title from the Elements list.

 2.  In the Character tab dialog, under Font Color, click Use this color, and click 
the Color button beneath it to open the Color dialog box.

 3.  Select a dark blue and click OK.

A sample of the color appears in the color box on the button, and a sample of 
text in that color appears in the box below.

 4.  Under Font Size, click Use this size. Then select Absolute size and 5, 
respectively, from the two drop-down lists.

 5.  Under Text Effects, click the Effects button to open that dialog box.

 6.  From the first drop-down list, opposite Bold, select Always On. Then click OK. 

The number you choose for size does not signify actual point size. Each web 
browser has an option for a base font size. So the display size of a given font may 
differ, depending on the base font size of the browser. By setting the text to an 
absolute size, you have more control over the size of the text onscreen. 

Let us format Heading 1 so that it will stand out, too, but not quite as much as Title.

 1.  From the Elements list, select Heading 1.
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 2.  You are still in the Character tab dialog. So repeat the steps above, this time 
setting the text color to a dark green and the absolute size of the font to 4.

Notice how easy it is in Formatting to stay in one tab dialog and select and format 
each element, in turn. Alternatively, you can move between tab dialogs in a 
property sheet as you complete the settings for a given element. It is all a matter of 
what you are trying to accomplish and how you prefer to work. 

Having set both color and font size for the Title and Heading 1 elements, let us align 
the Title element. 

 1.  From the Elements list, select Title again.

 2.  Click Paragraph to open that tab dialog. 

 3.  Under Alignment, click Use this alignment, and select Center from the drop-
down list.

You have now centered the content associated with the Title element on your web 
page. Placing a separator after the element Title will also help to set off the content 
associated with Title from the rest of the text.

To add a separator

 1.  With Title still selected in the Elements list, click Separators to open that tab 
dialog.

 2.  Check Insert separator after element.

Immediately, the full path and file name for the graphic Mroonspm.gif appears 
in the File Name text box, and the graphic itself displays in the Preview box. 
This happened, of course, because the graphic belongs to Maroon Sand, the 
graphics Set you selected as your default in Lesson 3. 

 3.  Under Alignment, make sure that Center is selected.

 4.  Click OK to leave Formatting.

You could have stayed in Formatting, because you are not quite done. But let us 
quickly review the changes made thus far in the Preview window in Edit Template.

Note the new font size for Title and Heading 1, the use of bold for Title, the use of 
color, and the placement of a separator after the title. Now let us return to 
Formatting, to complete the final task we set ourselves in this lesson: changing 
character settings. 

4 Click Formatting to open the property sheet once again. 

This time you are going to work with Introtext, the new element you created in 
Lesson 4. The content associated with Introtext is set in italic, and that is how it will 
display in the web page, too, unless you change it. Since whole paragraphs set in 
italic can be hard to read onscreen, you will change the element’s character 
settings.

To change character settings

 1.  Click Character to open that tab dialog and select Introtext from the 
Elements list.
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Figure 5-2  The Preview window in Edit Template, with the introductory text associated with the 
Introtext element set in italic.

 2.  Under Text Effects, click Effects to open that dialog box.

Click the down arrow opposite each effect to review the drop-down list of 
options. In each case, From Source keeps the text the same as in the source 
document, Always On makes all the text associated with that element have 
that attribute, and Always Off prevents any text from having that attribute. 

 3.  From the drop-down list after Italic, select Always Off. Then click OK to return 
to the Character tab dialog.

Figure 5-3  The Effects dialog box, with Italic set to Always Off for content associated with the 
Introtext element.

None of the text associated with this element will appear as italic in the web page. 
You can confirm this by clicking OK to return to the Edit Template dialog box once 
again, to review this latest change (see Figure 5-4).
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Figure 5-4  The Preview window in the Edit Template dialog box, with the introductory text 
associated with the Introtext element now set in regular text, not italic.

You might care to try one more task before you finish this lesson. With the Edit 
Template dialog box still open, scroll down to the end of the source document. In a 
previous lesson, you will recall, we added the copyright line. We also noted that you 
could format this, if you wanted to. Here’s your chance.

 1.  Click Formatting  to open the property sheet one more time.

 2.  From the Elements list, select Address (System).

You will recall from Lesson 4 that this element is used to format whatever 
information you place in the Address lines in the Address tab dialog of 
Globals. Experiment in the Character and Paragraph tab dialogs, changing the 
color, font size, and the alignment of the text. 

(By default, the <ADDRESS> tag is automatically assigned to the Address 
(System) element. As a result, content associated with this element will always 
display in italic because that’s how browsers interpret this tag. You can 
associate the element with the <P> tag, instead, if you want.)

When you are done, you should return to the main window and save your 
work. You can then translate and view your document. Only when you return to 
the main window, after clicking OK, have you, in fact, saved all your changes to 
the template.

 3.  Click OK in Formatting to return to the Edit Template dialog box (review your 
latest changes in the Preview window).

 4.  Click OK to return to the main window.

 5.  Click Save  on the toolbar to save your template changes to the project 
file.

 6.  Click Translate  on the large toolbar.

 7.  Click View .

Now see the difference that formatting can make to the look of a web page. With a 
few simple changes, you have dramatically altered the appearance of yours.
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Summary
This lesson offered an introduction to the power of formatting that is possible in 
Document Publisher Station from the Formatting property sheet. The Character 
and Paragraph tab dialogs are especially important. You will spend most of your 
time in Formatting working in these. You will explore some of the other formatting 
options in the Tutorial. 

Tips

Your changes in this lesson were not saved to the template until you clicked OK 
to leave the Edit Template dialog box. On the other hand, if you had not 
opened Edit Template to begin with and had returned directly to the main 
window from Formatting, your changes would have been saved to the 
template as soon as you exited Formatting. So the rule is simple: keep clicking 
OK to save your changes. When you finally return to the main window, that is 
when your changes are finally saved to the template. Of course, you should 
then save the template, and those changes, to the project file.

Formatting options are significantly greater with CSS (cascading style sheets) 
turned on. Document Publisher Station implements CSS by means of 
embedded, inline styles. For more information, see Lesson 2, “Formatting 
text,” in the Tutorial. 
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LESSON 6

Adding a TOC

One of the advantages of Document Publisher Station is its ability to automatically create 
a table of contents (TOC) for your publication. In this lesson, you will learn how to

Create a TOC

Promote content to the TOC

Pick a graphics Set for the TOC

Key concepts
The TOC you will create in this lesson is a publication TOC, which is one of four 
reference pages you can create in Document Publisher Station (the others are List of 
Figures, List of Tables, and Index). 

The publication TOC is different from the page TOC. Whereas the page TOC appears 
at the beginning of the web page for the source document and is part of that page, 
the publication TOC is a separate web page. And whereas the page TOC derives its 
content from a single source document, the publication TOC can derive its content 
from all the source documents in a publication. 

MyLesson is a simple publication, consisting of only one source document. So it 
does not really need a publication TOC. But the steps you will learn in this lesson 
will help you create one (or another reference page) for larger publications. 

Exercise
Open MyProjectFile. When you create a reference page, you do not need to select 
a source document in the Contents pane because you are adding the reference page 
to the publication. 

To add the reference page

 1.  Click Add Reference Page  on the toolbar.

The Add Reference Page dialog box opens (see Figure 6-1).

 2.  Make sure that Table of Contents (TOC) is selected.

Note that the default title for the TOC displays in the Name text box, and the 
default template, Default TOC, displays below that.

 3.  Click OK to return to the main window.
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Figure 6-1  The Add Reference Page dialog box. Note the default name for the Table of Contents and 
also the default template.

The Contents pane (Figure 6-2) now displays the new output page for the Table of 
Contents, with the template name in the Template column. The TOC has no source 
document of its own, of course, because it will derive its content from Source 
Documents.doc, the source document for the publication. 

Figure 6-2  The Contents pane displays the new reference page, Table of Contents.

To promote content to the TOC

Now that you have created the TOC, you must decide what content you want to 
place in it. You do this by “promoting” elements from the source document. By 
selecting which elements get promoted, you can control what goes into the 
reference pages you build. 

You will recall that we manage elements in the Element Setup property sheet. 

 1.  In the Contents pane, select Source Documents.doc and click Element 

Setup  on the toolbar.

You are in Element Setup once again, with the Elements tab dialog open. 

Typically, when you promote elements from source documents, you must then 
edit the reference page template to ensure that content associated with the 
promoted elements is actually placed in that reference page. However, 
Document Publisher Station automatically promotes two elements to a 
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publication TOC, should you decide to create one: Heading 1 and Title 
(System). You can tell this from the Promote As column in the Elements tab 
dialog (see Figure 6-3). Moreover, Document Publisher Station automatically 
includes the two promoted elements in the publication TOC, as we shall see.

Figure 6-3  The Elements tab dialog for the body page template, showing two elements promoted by 
default.

You can see that Heading 1 is being promoted as Heading 1, but that Title 
(System) is being promoted as Title. You have the option of promoting any 
element under a different name. By default, Title (System) is promoted as Title 
because the system elements are included in all the templates and the Table of 
Contents template will have its own Title (System) element. This special system 
element can be used to automatically create titles from information in your 
source documents. For a body page template, it consists of only the document 
title. (In the Titles tab dialog of Globals you can add other components to 
create a longer, more specific title.) 

Let us confirm the automatic promotion of two elements from the source 
document by editing the template for the Table of Contents. 

 2.  Click OK to return to the main window. In the Contents pane, select Table of 
Contents and open Element Setup once again. 

Figure 6-4  The Elements tab dialog for the TOC template, showing three elements included in the 
body of the TOC: Title (System) for the title of the TOC and the two promoted from the source document.
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When you enter Element Setup with a reference page template selected, several 
things are worth noting (see Figure 6-4):

The elements listed are those available for the TOC. They include the two 
elements promoted from the source document, as well as three “system” 
elements and two Default elements. 

The Title (System) element here is for the Table of Contents. The default in the 
case of a reference page template is the publication title plus the document 
title. So “MyLesson Table of Contents” will appear at the top of the web page. 

Two elements are by default promoted from the TOC: Title (System) as Title, 
and Title as Heading 1. These would only be relevant if you were promoting 
TOC entries through several levels in a publication hierarchy. 

The In Body column here refers to the TOC, not the source document. So 
whatever elements you select in the In Body column, you are placing the 
content associated with those elements in the body of the TOC. In this case, 
they are Heading 1, Title (originally Title (System) in the source document), and 
Title (System) for the reference page. They all have green check marks after 
them in the In Body column. 

The In Page TOC column is less relevant. A publication TOC can, in fact, have 
its own page TOC, and you might want to create one if the publication TOC is 
very long and detailed. (It might be helpful to summarize the publication TOC 
by using only key elements in the page TOC.) But we do not need it for our 
purposes.

 3.  Click OK to return to the main window.

 4.  Click Translate  on the toolbar.

 5.  Select Table of Contents and click View  on the toolbar.

Figure 6-5  The Table of Contents, showing content associated with the three elements included in 
the body of the TOC.

You can see the content associated with the three elements selected in the In Body 
column: “MyLesson Table of Contents” is associated with Title (System) for the TOC, 
“Source Documents” with Title (originally with Title (System) in the source 
document), and “Size” plus the other two headings with Heading 1. 

You will learn more about promoting elements and creating titles in the Tutorial. For 
now, remember that once you have selected all the elements you want to appear in 
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the TOC, you can then use Globals and Formatting to apply formatting just as you 
would to any source document template. Try that one on your own. 

To finish this lesson, let us pick a graphics Set for the TOC. What you will also have 
noticed in the web page for the TOC (Figure 21) is how plain the page is. We can 
correct this by associating a graphics Set with the reference page template. So click 
OK to return to the main window.

To pick a graphics Set

 1.  In the Contents pane, with Table of Contents selected, click Globals  to 
open that property sheet. 

 2.  Click Set to open that tab dialog. (Click one of the arrow buttons at the upper 
right, if necessary, to display the Set tab.)

 3.  Click Gallery to open the Gallery dialog box, and from the list of Sets, select 
Blue Bevel.

 4.  Click Make Default, and then OK.

 5.  Click Apply Set Selection, and click Yes when asked to confirm the Set.

You have now made Blue Bevel the default graphics Set for the TOC. However, you 
must still select the specific graphics from this Set you want to use for the TOC. An 
exception to this is the background graphic for the Set. Whenever you pick a Set 
and apply it, the background is immediately applied to all documents associated 
with the template. Let us confirm this.

 1.  Click Colors to switch to that tab dialog. (Click the arrow buttons at the upper 
right to display additional tabs.)

Under Background Colors, Use a background graphic is already checked and 
the path and name of the graphic displays in the File Name text box. In 
addition, the background graphic can be viewed in the Sample box. This 
graphic came, of course, from the Blue Bevel Set. Document Publisher Station 
automatically uses the background graphic whenever you associate a graphics 
Set with a template.

 2.  Click Separators to open that tab dialog, and click Insert separator after 
content. A graphic is selected immediately and displays in the Sample box.

You now have a background graphic in your TOC (automatically added by Document 
Publisher Station) and also a separator at the bottom of the TOC (added by you).

 1.  Click OK to return to the main window. You have just saved these changes to 
the template.

 2.  Click Save  on the toolbar to save your changes to the project file.
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Figure 6-6  The publication TOC for MyLesson, showing the background from the Blue Bevel graphics 
Set and also a separator after the content.

 3.  Click Translate  on the large toolbar.

 4.  With the Table of Contents still selected in the Contents pane, click View 

 on the large toolbar. Your web browser opens the Table 
of Contents (Figure 6-6). 

Summary
Let us analyze the web page for the Table of Contents you have just created so that 
we can appreciate all that is happened.

First, the main title, “MyLesson Table of Contents,” is derived from the Title 
(System) element, which is a default element that appears in every template you 
create. It has two components. The first component, “MyLesson,” is a publication 
property. When you named your publication “MyLesson,” you also used 
“MyLesson” for the publication title. You can confirm this by right-clicking MyLesson 
in the Publication Hierarchy pane and choosing Properties from the popup menu to 
open the Publication Properties dialog box.

The second component, “Table of Contents,” is the default name you accepted in 
the Add Reference Page dialog box (see Figure 6-1). Since it is a document 
property, you can confirm this by right-clicking Table of Contents in the Contents 
pane and selecting Properties from the popup menu. The Document Properties 
dialog box will open. Since both titles are properties, you can change them at any 
time. 

Your web page has a second title, “Source Documents.” Although this is the title in 
the content of the source document, which is associated with the Title element in 
the body page template, it actually comes from the Title element in the reference 
page template. That, of course, originated as Title (System) in the body page 
template. And by default, the Title (System) element in a body page template is 
simply the document title. The other three headings below Source Documents are 
content promoted because of its association with the Heading 1 element.

Finally, although your publication lacks navigation buttons (we will add them in the 
final lesson), your TOC is still linked to the source document because of the blue hot 
spot text. Click the title or any heading and you will jump immediately to the 
document. If you click a heading, you will go directly to that heading. So Document 
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Publisher Station not only picks up content from the source document to create a 
TOC, it automatically links that content to the source document. Document 
Publisher Station does this for any reference page you create.

Tip

Three of the reference pages available in Document Publisher Station actually work 
the same way: Table of Contents (TOC), List of Figures (LOF), and List of Tables 
(LOT). That is, you could add a LOF or LOT to your publication and create a TOC 
just as you would if you added a TOC in the Add Reference Page dialog box.

The Index derives its content from index markers in the source documents. So you 
can build an index only if the source documents contain index markers. The Index is 
therefore different from the three reference pages mentioned above, which derive 
their content from elements promoted from the source documents. 

By making a graphics Set the default for your template does not mean you can use 
only graphics from that Set in your publication. In fact, you can choose any graphics 
you prefer, even with a Set associated with a template. The purpose of the Set is to 
help impose a consistent, professional design throughout your publication with 
minimum effort.
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LESSON 7

Adding navigation buttons

In this lesson, you will add navigation buttons to

Help readers jump from the bottom to the top of your web page

Link the source document to the TOC

Link the source document to another web page

Key concepts
Navigation buttons perform an important role in web pages, helping readers move 
within and between the pages of your web publication. Document Publisher Station 
simplifies the adding of navigation buttons by automating the selection process and 
speeding up the choice of graphics with the use of a default graphics Set. 

Exercise
 1.  Open MyProjectFile.tcp.

 2.  Select Source Documents.doc.

 3.  Click Navigation  on the toolbar.

The Navigation property sheet opens with the Page Button Bar tab dialog in front 
(see Figure 7-1). On the left is a list of the different types of links that Document 
Publisher Station can create automatically. On the same line opposite each link are 
two red crosses to denote that you have not set any links yet. 

To add navigation from the bottom of the page to the top

 1.  Under Link Type, select Top of Page. 

 2.  Double-click the second red cross, under After.

Under Link Icon, the path to the Top of Page button appears and the button itself 
displays in the Bottom of Page Preview window. You should recognize the style of 
the button. It is from the Maroon Sand graphics Set you chose in Lesson 3 for the 
source document. That is one of the benefits of having a graphics Set already 
selected. You do not have to go hunting for a graphic each time.

By the way, the links you set on the Page Button Bar tab dialog all relate to the web 
page as a whole. So Before and After refer to the top and bottom of the web page, 
respectively. 
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To add links to the TOC

Next you need to add a button to take you from the source document to the TOC.

 1.  Select Table of Contents from the list of Link Types and place buttons at the 
top and bottom of the page by turning both the red crosses to green check 
marks (a double-click will do it each time).

Figure 7-1  The Navigation property sheet, showing the standard set of links you might want to use 
for any web page.

The TOC button from the graphics Set automatically pops up in both Preview 
windows, and the path to this button appears under Link Icon. 

For some link types, such as Specific Page, you might need to choose a specific 
button. You do this in the Gallery. 

To add a link to another web page

 1.  Under Link Type, select Specific page 1 and change the red cross under After 
to a green check mark. 

The Home page button automatically appears. If you want to use a different 
button, click Gallery and select one from the Maroon Sand Set. 

 2.  Click the Properties button to open the Link Properties dialog box (see 
Figure 7-2).
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Figure 7-2  The Link Properties dialog box, where you can enter a link for your web page that will take 
you to any web site.

 3.  In the Specific Page URL text box, type http://www.filenet.com, and click OK.

You have added a link to the FileNet home page. You can link to any URL anywhere 
in this manner, just as long as you enter the complete URL in the Specific Page Link 
text box. Look at the results in Figure 7-3.

Figure 7-3  The Navigation property sheet, showing the addition of navigation buttons to the source 
document.

This is all it takes to add navigation buttons to your web page. Let us see what you 
have accomplished.

 1.  Click OK to save your changes to the template and return to the main window.
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 2.  Click Save  on the toolbar to save the template to the project file.

 3.  Click Translate  on the large toolbar.

 4.  With Source Documents.htm selected in the Contents pane, click View  to 
open your web browser.

First you will notice the TOC icon at the top of the page. Click this button and you 
will switch to the Table of Contents page. This page does not have any navigation 
buttons as yet, so click Back on the browser toolbar to return to the source 
document. Now scroll to the bottom of this page and you will see three buttons. 
Top will take you to the top of the page you are on, TOC will take you back to the 
TOC again, and Home will take you to, well, try it…

Before we close out this lesson, you might care to add similar navigation buttons to 
the Table of Contents. (In the Contents pane, select Default TOC and open 
Navigation.)

Summary
Navigation buttons are a powerful tool for ensuring that your readers can find their 
way around your web publications with ease and always know how to get back to 
their starting point in the publication. The larger and more complex your 
publications are, obviously the more important navigation becomes. Navigation can 
also be accomplished with text bars (see the other tab dialogs in Navigation). Keep 
in mind, too, that Document Publisher Station lets you create navigation links 
between elements as well as pages. 

Now that you have seen how simple it is to create a page button bar, you might 
want to experiment with the other tab dialogs available in Navigation before 
moving on to the Tutorial.
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